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Abstract 
In modern digital environments, traditional notice 
boards are inefficient due to manual updating and 
limited accessibility. This paper presents a Wireless 
Electronic Notice Board System that allows users to 
update messages wirelessly via voice commands 
using a mobile application. The system integrates 
Bluetooth communication, voice-to-text conversion, 
and microcontroller-controlled message display, 
making it suitable for educational institutions, 
offices, public facilities, and information centers. 
Users speak the message into the AMR Voice 
Android application, which converts speech into text 
using Google’s speech recognition technology. The 
text is transmitted via an HC-05 Bluetooth module 
to an Arduino UNO microcontroller, which displays 
the message on a 16×2 LCD. For messages 
exceeding the display area, an auto-scrolling 
feature ensures full readability. 
The proposed system is low-cost, efficient, and user-
friendly, offering hands-free operation while 
reducing manual effort and paper usage. It 
demonstrates the potential for smart communication 
tools that bridge traditional methods with modern 
embedded and wireless technologies. 
 
Introduction 
Wireless communication has become a key 
component of modern commercial and academic 
applications over the past decade. With mobile 
subscriptions surpassing wired connections, low-
cost, low-power, short-range wireless 
communication—such as personal wireless 
networks—has gained significant attention. 
Advances in embedded systems and communication 
technologies have enabled the integration of 
computational processing, wireless communication, 
and other functionalities into compact and cost-
effective devices. These devices have applications 
ranging from industrial automation to homeland 
security, enabling tailored solutions for information 
dissemination and monitoring. As such, engineers 
with expertise in embedded systems and wireless 
communication are increasingly in demand. 
Communication plays a critical role in the efficient 
functioning of institutions such as schools, offices, 
and public facilities. Traditional notice boards, 
while widely used, require manual updating, which 
is time-consuming, inflexible, and inefficient. The 
integration of wireless and embedded technologies 

presents an opportunity to modernize these boards, 
making updates faster, more convenient, and 
interactive. 
This project proposes a Wireless Electronic Notice 
Board System that allows real-time message 
updates via Bluetooth using voice input through a 
mobile application. Users speak into the AMR 
Voice Android app, which converts speech into text 
using Google’s speech recognition. The text is 
transmitted wirelessly via an HC-05 Bluetooth 
module to an Arduino UNO microcontroller, which 
displays the message on a 16×2 LCD. To 
accommodate longer messages, an auto-scrolling 
feature ensures the full text is visible. 
The system is designed to be user-friendly, cost-
effective, and portable, making it accessible to 
non-technical users. The voice-based interface 
promotes hands-free and contactless operation, 
particularly beneficial in environments where 
hygiene or rapid communication is important, such 
as hospitals or classrooms. 
From a technical perspective, this project 
demonstrates the integration of hardware and 
software, including microcontroller programming, 
serial communication, and mobile app interaction. 
Furthermore, it serves as a foundation for advanced 
smart display systems, potentially incorporating IoT 
connectivity, cloud-based updates, multi-language 
support, scheduling, and remote monitoring. 
 
Aim of the Project 
The main goal of this project is to design and 
implement a smart, wireless notice board system 
that leverages Bluetooth communication and voice 
recognition to display real-time messages on an 
LCD screen using an Arduino-based platform. 
Specific Aims: 

 Wireless Communication: Establish a seamless 
Bluetooth connection between a smartphone and the 
noticeboard for message transmission.  

 Voice-to-Text Conversion: Use the AMR Voice 
app to convert spoken messages into text for display.  

 Real-Time Display: Show messages immediately 
on the LCD screen.  

 Auto-Scrolling Feature: Ensure long messages are 
fully visible via scrolling.  

 Cost-Effective Design: Use affordable, readily 
available components (Arduino UNO, HC-05, 16×2 
LCD).  
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 Hands-Free Operation: Enable users to update 
notices without physical interaction.  
This approach aligns with the trend toward smart 
infrastructure, demonstrating how traditional 
communication tools can be enhanced using 
embedded systems and mobile technologies. 
 
Motivation 
Manual updating of noticeboards in institutions and 
public places is time-consuming and inefficient. The 
motivation for this project includes: 

 Providing a wireless, hands-free notice update 
system.  

 Reducing paper wastage and promoting 
sustainability.  

 Making communication accessible, fast, and 
modern.  

 Allowing non-technical users, such as teachers or 
administrators, to update notices using voice 
commands.  
Objectives 

 Design a low-cost, user-friendly wireless notice 
board.  

 Interface the HC-05 Bluetooth module with Arduino 
UNO.  

 Enable voice-to-text message input through the 
AMR Voice app.  

 Implement auto-scrolling for long messages on a 
16×2 LCD.  

 Demonstrate real-time, efficient notice 
communication.  

 Ensure accessibility for users with minimal 
technical knowledge.  
 
Literature Review 
Prior studies explored GSM, Bluetooth, and Wi-Fi-
based notice boards: 

 GSM-based systems (S. Rajitha & K. Sri Rama 
Krishna, 2014) allowed SMS messages but incurred 
recurring SIM costs and lacked voice support.  

 Bluetooth-based systems (J.S. Jadhav & Aniket S. 
Lokhande, 2015) enabled typed text transmission 
but were limited to manual input.  

 Voice-controlled boards (Prashanth P.R. & 
Naveen Kumar S., 2017; K. Manikandan & G. 
Sathya, 2018) lacked efficient handling of long 
messages.  

 IoT-enabled boards (V. Praveen Kumar & G. Ram 
Mohan, 2018) offered cloud integration but required 
continuous internet access.  
The proposed system addresses these gaps by 
combining voice input, Bluetooth connectivity, 
and auto-scrolling in a low-cost, portable solution 
suitable for real-time applications. 
 
Software and Hardware Requirements 
This chapter discusses the software and hardware 
requirements for the implementation of a Wireless 
Voice-Enabled Notice Board using Bluetooth HC-
05. The system combines Arduino-based 
microcontroller programming with a mobile app 
interface to enable wireless voice-controlled 
message display on an LCD. 
 
Software Requirements 
The software environment provides tools for 
writing, compiling, and uploading the source code to 
the Arduino microcontroller. Key software 
components include: 

 Arduino IDE: A cross-platform application for 
Windows, macOS, and Linux that allows code 
development and uploading to Arduino boards.  

 AMR Voice App: An Android application 
developed using the MIT AI2 Companion platform. 
It enables voice-to-text conversion and sends 
commands via Bluetooth to the Arduino.  

 
Fig 1 Arduino UNO 
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Fig 2 An A-to-B USB Cable 

 
 
Arduino IDE Setup 

1. Driver Installation:  
o Connect the Arduino board to a computer via USB.  
o If Windows identifies the device as “Unknown,” 

update the driver manually by selecting the 
ArduinoUNO.inf file from the IDE’s Drivers folder.  

2. Testing the Board:  

o Open the Blink example from File > Examples > 
1.Basics > Blink.  

o Select the board type: Tools > Board > Arduino 
UNO.  

o Select the appropriate COM port: Tools > Port > 
COMxx.  

o Upload the program; the onboard LED should start 
blinking, indicating successful programming.  

 

 
Fig 3 : Unknown Device Listed in Device Manager 

 Right click on the “Arduino UNO (COMxx)” or 
“Unknown Device” port and choose the “Update 
Driver Software” option 

 Next, choose the “Browse my computer for Driver 
software” option 

 

 
Fig 4 Arduino IDE Menu Showing Example Sketches 

 Select the type of Arduino board you’re using: Tools > Board > your board type 
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Fig 5 Arduino IDE Menu Showing Tools for board selection 

 Select the serial/COM port that your Arduino is attached to: Tools > Port > COMxx 

 
Fig 6 Arduino IDE Menu Showing Tools for serial port 

 
 

 If you’re not sure which serial device is your 
Arduino, take a look at the available ports, then 

unplug your Arduino and look again. The one that 
disappeared is your Arduino. 
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 With your Arduino board connected, and the Blink sketch open, press the ‘Upload’ button 

 
Fig 7 Blink Example Code Loaded in Arduino IDE 

 
AMR Voice App Functionality The AMR Voice app provides wireless control of 

devices using Bluetooth and voice commands. Key 
features include 

 
Fig 8 AMR VOICE App Interface for Voice-Controlled Bluetooth Communication 

 
 Bluetooth Communication: Establishes a wireless 

connection between a smartphone and the Arduino.  
 Voice Recognition: Converts spoken input into 

actionable commands.  

 Control Methods: Users can interact via app 
buttons or voice commands.  

 Customization: Voice commands can be tailored 
for specific actions.  
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 Hands-Free Operation: Enables control without 
manual intervention, useful in classrooms or public 
spaces.  
 
Use Cases: Robots, home automation, and general 
device control via voice commands. 
2.3 Hardware Requirements 
The hardware components for the project include: 

 Arduino UNO: A microcontroller board based on 
the ATmega328P with 14 digital I/O pins (6 PWM), 
6 analog inputs, 16 MHz clock, USB interface, and 
power jack.  

 HC-05 Bluetooth Module: Enables short-range 
wireless communication with smartphones.  

 16×2 LCD Module: Displays messages; supports 
both 4-bit and 8-bit communication modes.  

 MAX232 IC: Converts TTL logic signals from 
Arduino to RS-232 voltage levels for serial 
communication.  

 Power Supply: Provides regulated 5V DC power 
for the system.  

 Miscellaneous Components: Jumper wires, 
resistors, and connectors for interfacing.  
 

 
Fig 9 ARDUINO UNO 

 
Arduino UNO Features 
11 Features of Microcontroller 
 

 
Fig 10  At mega pin mapping 



ISSN 2347–3657 

Volume 14, Issue 1, 2026 
 

571 
 

 

 
 

Fig 11 Arduino pins 
 
LCD Module Overview 
The 16×2 LCD consists of two lines with 16 
characters per line. It uses: 

 Data Pins (D0–D7): Transmit characters and 
commands.  

 Control Pins (RS, RW, EN): Manage 
command/data selection and read/write operations.  

 Backlight Pins (A, K): Power the backlight for 
visibility.  
The LCD operates in either 4-bit or 8-bit mode; 8-
bit mode allows faster updates, whereas 4-bit mode 
reduces the number of data lines used. 
Bluetooth Architecture 
Bluetooth operates in a master-slave configuration 
within ad-hoc networks called piconets, supporting 
up to seven active slave devices per master. Multiple 
piconets can form a scatternet, allowing devices to 
participate in multiple networks. Key features 
include robustness, low power consumption, and 
short-range communication suitable for personal 
area networks. 
MAX232 and RS-232 Communication 
The MAX232 IC converts TTL logic levels from 
Arduino to RS-232 voltage levels for serial 
communication. Data is transmitted in frames with 
a start bit, data bits (LSB first), optional parity, and 
stop bit(s). 
 
Wireless Notice Board Using Bluetooth 
This chapter presents the design, methodology, and 
implementation of a Wireless Notice Board using a 
Bluetooth HC-05 module. The system enables real-
time display of notices through voice commands via 
an Android mobile application, addressing the 
limitations of conventional and internet-dependent 
digital notice boards. 

Existing System 
Traditional notice boards are widely used in schools, 
colleges, offices, hospitals, and public transport 
areas to display announcements or instructions. 
These boards are primarily manual, requiring 
physical updates, which are labor-intensive and 
slow. Digital noticeboards with LED or 
microcontroller interfaces have emerged, relying on 
wired or internet-based communication. 
However, they present several challenges: 

 Manual Operation: Updates require physical 
presence and effort.  

 Wired Connectivity: Some systems require USB or 
LAN connections.  

 Limited Remote Access: Updates cannot be 
performed from a distance without network access.  

 Internet Dependency: IoT-enabled boards require 
stable Wi-Fi or cellular connectivity, unsuitable for 
remote areas.  

 No Voice Control: Lack of hands-free operation 
limits accessibility.  

 Limited Readability: Long messages may not 
display properly on small screens without scrolling.  
These limitations reduce the efficiency, 
accessibility, and adaptability of existing 
noticeboard systems, especially in environments 
requiring frequent or urgent updates. 
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Proposed System 
The proposed system introduces a wireless, voice- 

 

Figure 12: Block Diagram of Wireless Notice Board 
 
 
controlled notice board using Bluetooth 
technology. It integrates an Android app with 
voice-to-text functionality and a 16×2 LCD with 
auto-scrolling capability, addressing the 
shortcomings of prior systems. 
System Design Overview 
The system consists of two primary modules: 
A. Input Module (Mobile App + Voice 
Recognition) 

 The user speaks into the AMR Voice App on an 
Android smartphone.  

 The app converts speech to text using the Google 
Speech API.  

 The resulting text is transmitted via HC-05 
Bluetooth to the microcontroller.  

  
B. Processing & Display Module 

 The HC-05 module receives text and forwards it to 
the Arduino UNO microcontroller.  

  
 The Arduino stores and processes the message, 

displaying it on the 16×2 LCD.  
 For messages exceeding 16 characters, an auto-

scrolling function ensures full visibility.  
Proposed System Workflow 

1. Open the AMR Voice App on an Android device.  
2. Speak the notice into the app.  
3. Convert speech to text and send it via Bluetooth.  
4. HC-05 receives the message and transmits it to the 

Arduino.  
5. Arduino:  
o Stores and interprets the message.  
o Scrolls long messages smoothly from right to left.  
6. LCD continuously displays the latest message until 

a new one is received.  

 
 
Steps in the Block Diagram: 

1. Voice Input via Mobile (AMR Voice App): 
Speech is captured and converted to text.  

2. Bluetooth Communication (HC-05): Text is 
transmitted wirelessly to the HC-05 module, 
operating in slave mode via UART protocol.  

3. Signal Level Conversion (MAX232): Converts 
RS-232 voltage levels from HC-05 to TTL logic 
compatible with Arduino.  

4. Data Processing (Arduino UNO):  
o Receives converted text.  
o Identifies message length and determines whether 

auto-scrolling is needed.  
5. Message Display (LCD): Text is displayed on a 

16×2 LCD with auto-scrolling for long messages.  
Advantages 
The wireless notice board system offers several 
advantages over conventional manual and semi-
digital boards. By using Bluetooth technology, it 

eliminates the need for physical wiring or internet 
connectivity, making installation and maintenance 
straightforward. Bluetooth modules, such as the HC-
05, consume very little power, allowing for energy-
efficient operation and suitability for battery-
powered setups. The system is cost-effective since 
components like the Arduino microcontroller and 
Bluetooth modules are inexpensive, and no 
recurring internet charges are required. Updates can 
be made remotely through a smartphone or laptop, 
removing the need for manual writing or printing, 
which significantly reduces effort and paper usage. 
Its compact and portable design, due to minimal 
wiring requirements, allows easy relocation, making 
it ideal for temporary events, classrooms, 
workshops, or hostels. The system supports 
localized communication since the Bluetooth range 
of 10–30 meters restricts updates to nearby 
authorized users, enhancing security. Integration 
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with voice-to-text apps or custom mobile 
applications enables hands-free operation, which is 
particularly useful for visually impaired users or 
fast-paced environments. The system ensures real-
time updates and reliable message display within 
small areas, making it well-suited for schools, 
colleges, offices, and residential campuses. 
Disadvantages 
Despite these advantages, there are certain 
limitations. The short-range nature of Bluetooth can 
restrict usability in large buildings or campuses, and 
physical obstacles or interference can further reduce 
effective communication. Operating on the crowded 
2.4 GHz frequency band, Bluetooth may experience 
interference from devices such as Wi-Fi routers, 
microwaves, or cordless phones. While the data 
transfer rate is sufficient for text-based messages, it 
may not accommodate multimedia content or large 
data files efficiently. Security concerns arise as 
Bluetooth connections are susceptible to 
eavesdropping, unauthorized access, and spoofing if 
proper encryption is not implemented. Device 
compatibility issues may occur due to different 
Bluetooth versions and profiles, leading to potential 
pairing failures. Standard Bluetooth modules, 
although low-power, still consume more energy 
during continuous operation, which may require 
frequent battery replacement in portable setups. 
Most modules are designed for one-to-one 
communication, complicating broadcasting to 
multiple boards simultaneously, and initial device 
pairing can be cumbersome in environments with 
multiple users. 
 
Applications 
The applications of this system are extensive across 
educational, corporate, healthcare, public, and 
residential environments. In educational institutions, 
schools, colleges, and universities can use the 
system to display exam schedules, class 
cancellations, and event updates, efficiently 
communicating across classrooms and departments. 
In offices, the notice board can broadcast reminders, 
meeting schedules, and emergency alerts without 
printed circulars, enabling real-time updates. 
Hospitals and clinics can place the boards in waiting 
areas or departments to display queue numbers, 
health tips, and emergency announcements, 
improving communication efficiency. Public 
transport stations, such as bus stops or small railway 
stations, can use these boards to provide arrival and 
departure times, delays, or route changes from a 
nearby control room. Retail outlets, shopping malls, 
and stores can display offers, event notifications, or 
directional information, updated instantly via 
mobile devices. During exhibitions, trade fairs, and 
conferences, organizers can provide session 
schedules, speaker details, and venue changes 
without needing physical updates. Government 
offices and municipal buildings can keep citizens 

informed about operational timings, 
announcements, and queue numbers, while hostels 
and residential campuses can display mess 
schedules, visitor information, and safety 
instructions remotely. 
 
Results and Discussion 
This chapter presents the results and discussion of 
the wireless notice board system implemented using 
Bluetooth communication. The system is designed 
to enable wireless display of messages, offering a 
modern alternative to traditional notice boards. 
System Operation 
The wireless notice board system operates by 
receiving messages sent from Bluetooth-enabled 
devices, such as smartphones or laptops. The core of 
the system is a microcontroller—commonly an 
Arduino Uno, NodeMCU, or equivalent—which 
controls the overall operation. Communication is 
facilitated via a Bluetooth module, typically the HC-
05 or HC-06. The display component can be an LCD 
(Liquid Crystal Display) or an LED matrix, 
depending on the required output format. Power is 
supplied through a DC source or battery, with 
voltage regulation ensuring stable operation. 
The user first pairs their mobile device with the 
Bluetooth module, a process that is usually required 
only once, as the module stores pairing information. 
Once paired, messages are transmitted wirelessly 
using a serial Bluetooth terminal application or a 
dedicated Android app. The Bluetooth module 
receives the data and forwards it to the 
microcontroller through its RX (receive) and TX 
(transmit) pins. 
The microcontroller continuously monitors for 
incoming data. Upon receiving a message, it 
temporarily stores the data, processes it, and 
converts it into a display-compatible format. For 
LCDs, the text is formatted into multiple lines, with 
appropriate commands handling line breaks and 
alignment. For LED matrices, characters are 
translated into pixel patterns and scrolled across the 
screen. 
The displayed message remains active until a new 
message is received, at which point it is replaced. 
Advanced implementations may include a real-time 
clock (RTC) or memory storage to retain messages 
during power interruptions. Additionally, some 
systems may incorporate buttons for manual reset or 
automated message updates at fixed intervals. 
Overall, this system offers a cost-effective, wireless 
solution for short-range communication, suitable for 
environments such as schools, offices, and hostels 
where frequent message updates are required 
without physical intervention. 
The wireless notice board system was successfully 
implemented and tested. The setup comprised a 
microcontroller (Arduino), an HC-05 Bluetooth 
module, and an LCD/LED display. Messages sent 
from a Bluetooth-enabled mobile device using a 
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serial terminal app were received and displayed 
accurately on the board. 
The display updated instantly upon receiving new 
messages, demonstrating real-time message 
handling without any manual interaction. The 

Bluetooth connection was stable within the typical 
operational range of approximately 10 meters. The 
system reliably displayed messages of varying 
lengths and content, confirming its effectiveness as 
a modern alternative to conventional notice boards.

 

Figure 13: LCD displaying the received message. 
 
The results indicate that the proposed wireless notice 
board is a practical solution for short-range 
communication, enabling seamless message updates 
and reducing the need for physical intervention. 
 
Conclusion 
The Bluetooth-based Wireless Notice Board 
provides an effective and convenient solution for 
modern communication requirements in educational 
institutions, offices, and public areas. By eliminating 
the need for manual updates, the system enables 
remote message posting through a smartphone 
interface. The successful implementation 
demonstrates the capability of low-cost embedded 
systems to facilitate real-time information sharing. 
The system operated reliably within its expected 
range, delivered instant message updates, and 
proved suitable for short-distance applications. 
Overall, the project achieves its goal of offering a 
smarter alternative to traditional notice boards, 
combining straightforward hardware with wireless 
technology for enhanced usability and efficiency. 
 
Future Scope 
Although the current system meets basic messaging 
needs, several enhancements can improve its 
functionality and versatility: 

1. Extended Connectivity: Replacing the Bluetooth 
module with Wi-Fi or GSM can increase the 

communication range and enable remote message 
updates from any location.  

2. Scheduled Messaging: Integration of a real-time 
clock (RTC) allows time-based automated message 
updates.  

3. Smart Display Features: Incorporating sensors, 
such as motion or temperature sensors, can 
transform the notice board into a smart, context-
aware display system.  

4. Mobile Application Development: A dedicated 
mobile app with enhanced UI, message history, user 
authentication, and notifications can improve 
usability and security.  

5. Accessibility Enhancements: Adding multi-
language support and voice-to-text functionality 
would make the system more user-friendly and 
inclusive.  
These improvements can expand the applicability of 
the wireless notice board, transforming it from a 
simple messaging system into a comprehensive, 
intelligent communication platform suitable for 
diverse environments. 
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